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Contacting Ascend Customer Service

Contacting Ascend Customer Service

You can request assistance or additional information by telephone, email, fax, or
modem, or over the Internet.

Obtaining Technical Assistance

If you need technical assistance, first gather the information that Ascend
Customer Service will need for diagnosing your problem. Then select the most
convenient method of contacting Ascend Customer Service.

Information you will need

Before contacting Ascend Customer Service, gather the following information:
*  Product name and model

» Software and hardware options

»  Software version

» Service Profile Identifiers (SPIDs) associated with your product

* Your local telephone company’s switch type and operating mode, such as
AT&T 5ESS Custom or Northern Telecom National ISDN-1

*  Whether you are routing or bridging with your Ascend product
e Type of computer you are using
» Description of the problem

How to contact Ascend Customer Service

After you gather the necessary information, contact Ascend in one of the
following ways:

Telephone in the United States 800-ASCEND-4 (800-272-3634)
Telephone outside the United States 510-769-8027 (800-697-4772)
Austria/Germany/Switzerland  (+33) 492 96 5672
Benelux (+33) 492 96 5674
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Contacting Ascend Customer Service

France (+33) 492 96 5673
Italy (+33) 492 96 5676
Japan (+81) 3 5325 7397

Middle East/Africa

(+33) 492 96 5679

Scandinavia (+33) 492 96 5677
Spain/Portugal (+33) 492 96 5675
UK (+33) 492 96 5671
Email support@ascend.com
Email (outside US) EMEAsupport@ascend.com
Facsimile (FAX) 510-814-2312

Customer Support BBS by modem 510-814-2302

You can also contact the Ascend main office by dialing 510-769-6001, or you can
write to Ascend at the following address:

Ascend Communications, Inc.,
One Ascend Plaza,

1701 Harbor Bay Parkway,
Alameda, CA 94502

Need information about new features and products?

Ascend is committed to constant product improvement. You can find out about
new features and other improvements as follows:

* For the latest information about the Ascend product line, visit our site on the
World Wide Web:

http://www.ascend.com

* For software upgrades, release notes, and addenda to this manual, visit our
FTP site:

ftp.ascend.com
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Introduction 1

The Pipeline is a cross-platform ISDN Terminal Adapter. Cross-platform support
is provided via a standard serial port interface for PC, Macintosh, and UNIX
workstations. The Pipeline comes standard with dual analog ports for phone and
fax machine support.

The Pipeline is intended for:

» Telecommuting, with full data and analog phone and fax support for the
complete home office.

* Internet access, with dynamic bandwidth for cost-effect, yet high-speed web
access.

* On-line services access, with compatibility with all major service providers,
such as Microsoft Network, AOL, and CompuServe.

* Peer-to-peer networking, for direct file transfers between small offices or
remote customers.

* Remote access, with up to 128Kbps transfer rates.

Pipeline 15 features

The Pipeline connects your PC, Mac, or UNIX machine to an ISDN line at rates
up to 128Kbps for high speed, cost effect network or Internet access, plus
supplies you with two phone jacks that can each be attached to a phone or fax
machine which can be used at the same time you are transmitting data over the
ISDN line.

Incoming voice calls are automatically directed to one of the analog phone ports,
and data calls are handled by the customizable digital services of the Pipeline.
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Introduction
What you need to start using the Pipeline

The Pipeline is ready for telecommuting and Internet connections with built-in
support for PPP, MP, MP+, BACP, and V.120.

On the accompanying CD you'll find an easy-to-use setup program that can
detect most of your setup information for you—you supply your ISDN phone
number(s) and the number you want to call and you're on your way.

Additionally, the Pipeline features:

» Advanced calling features, such as call hold, drop, transfer, and Caller ID

»  Support for Microsoft Dial-Up Networking

* A customizable Idle Timer that hangs up calls after a specified period of
inactivity

e Support for both PAP and CHAP security

* On-board software can be upgraded in moments after downloading updates
from ftp.ascend.com

* CD-ROM with MAXLink Pro client software, MS Internet Explorer,
Microsoft Network, QuickLink Il Fax, TurboComm/2 (remote access tools
to help you reach other computers and transfer data)

What you need to start using the Pipeline

You need the following hardware and software before you can use the Pipeline.

System requirements

In order to install the Pipeline, you must have ISDN service, an available serial
port on your computer, and for advanced customization, you will need
communications software. Additionally, you need a CD-ROM drive to access the
installation software. The customized settings for the Pipeline are stored on-
board the Pipeline in flash memory (whichmat erased when the Pipeline is off).

Finding a serial port

On a PC a serial port is usually a DB25- or DB9-pin connector labeled COM,
Serial, or RS-232-D. On a Macintosh, a serial port is a mini DIN 8-pin connector
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Introduction
Box contents

with a phone icon. The cable provided with the Pipeline is a 25-pin male to 9-pin
female serial cable.

You may need a cable or cable adapter

Check your computer’s serial connector and compare it to the cable provided.
The Pipeline side of the connection uses the 25-pin connector. Depending on the
type of serial connector on your computer, you may need a 25-pin to 9-pin
adapter. If you have a Macintosh, you will need to supply a 25-pin to mini DIN 8-
pin cable.

Communications software

To customize the Pipeline you need communications software that can emulate a
VT100 terminal (that is, display a screen that uses character-mode input). For
Windows users, the Hyperterm program that ships with Windows can be used.
For the Macintosh, if you need communications software, use the Zterm
communications package, available at ftp.ascend.com/pub/Utilities.

Box contents

The Pipeline package contains one each of the following:
* Pipeline 15 ISDN Terminal Adapter.
* Power cable with an AC wall transformer.

* RJ-45t0 RJ-11 ISDN cable. The wider end is the RJ-45, which plugs into the
Pipeline. The narrower end is a standard RJ-11, which plugs into the ISDN
outlet installed by your service provider.

* Pipeline Companion CD-ROM, which contains the setup software for the
Pipeline.

« Start Here installation and quick reference card.
* Pipeline 15 User’s Guide.
If you are missing any item, or if you need diskettes instead of the CD-ROM,

please call Ascend’s Technical Assistance Center. The number in the US is (800)
272- 3634. Outside the US, call (510) 814-2333.
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The big picture 2

How to use ISDN

If you have ever used a modem to communicate with a remote computer, you will
find that using an ISDN modem, or terminal adapter, is very similar. To use the
Pipeline 15 to connect to another computer:

« Dial the remote computer.

e Connect using an agreed upon security protocol and transport protocol
(described below).

* Transfer data.

The big difference when using ISDN is that both ends of a data connection must
be digital and able to communicate in ISDN format. So whenever you receive
data calls, the calling end needs to be on an ISDN line. If you are using your
Pipeline 15 to connect to the Internet, your Internet Service Provider must be able
to accept ISDN calls, and you might need a new account to use with your ISDN
line. And if you are using your Pipeline 15 to telecommute, your corporate

system administrator needs to be able to accept an ISDN call, and needs to give
you information about how to configure your Pipeline so that your connection

can be authenticated (pass a security check) before you can access the corporate
network.

The Pipeline 15 is often referred to as an ISDN terminal adapter. A terminal
adapter is a device that allows both voice (analog) and data (digital) connections
to be made from a single device. A very useful feature of ISDN is that it
integrates voice call services with digital data call services.
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ISDN basics

Basic Rate

Ordering ISDN service is called “provisioning the line.” If you need help
provisioning your ISDN line, refer to Ascend’s web site at www.ascend.com
where you can find an html page all about provisioning an ISDN line in North
America. Additionally, Ascend’s Technical Assistance Center can give you all
the information you'll need when you talk to your phone company.

If you need help with some of the terms associated with ISDN or with basic
networking functions, please see the Networking Glossary on the Pipeline
Companion CD. The Networking Glossary is an HTML title that you read with a
web browser. Refer to the A-to-Z section for an explanation of hundreds of terms.
The Basics section shows you how ISDN works in full color, animated segments.

Interface (BRI)

When you order ISDN service for your home or small office, you get what is
known asBasic Rate Interface. This gives you three channels: 2 B channels with
a capacity of 64 kbps each, and a single D channel with a capacity of 16 kbps.

Whenever you make an ISDN call, you start with one B channel. If the receiving
end can accept the other B channel, and if the data requirements of your call need
the extended bandwidth, your Pipeline uses the second B channel. But you can
set up the Pipeline to use only one B channel when connected to a given phone
number. Bringing up the second B channel costs more. Sometimes there is a
premium charge from the phone company for the first minute, so be aware that
bringing up two channels can cost more even though the call is shorter. Also
check with the remote end to see if there are additional charges when connecting
with both B channels, and to make sure the remote end can handle a two-channel
call.

The D channel is used by the ISDN service for administrative tasks. It is
generally not used by the consumer (although there are some commercial
applications, such as credit card approvals, that make use of the narrow
bandwidth of the D channel). You can make or receive voice calls while data
calls are in progress if your ISDN service is provisioned for both voice and data.
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Integrated digital and analog services

ISDN service can be customized. You can choose whether each of your B
channels can be used for just data, data or voice, or just voice. In this context,
voice means plain old telephone service (and is actually called POTS). POTS
services are analog instead of digital. Analog service is what your phone, fax, and
ordinary modem use. If you choose to have voice integrated into your ISDN line
(which is the standard), you can make and receive calls by plugging a phone (or
two) into the back of the Pipeline. In fact, you can plug in any analog phone
device, including a fax machine or a modem. For a small office, this gives you
one phone-service account for all your telephone usage, plus your Internet and
corporate dial-up charges.

Connecting to a switch

Ordering ISDN service is actually requesting a line frosavéchat your local
telephone company. The most common switches in North America are the AT&T
Electronic Switching System (known as AT&T 5ESS) and Northern
Telecommunication’s DMS-100 switch. These switches are actually computers
that route calls between their sources and destinations. They use different types
of software. When you set up your Pipeline, you will be asked to identify the
switch, which actually refers to the switch-software combination.

Switches (and their software combinations) supported by the Pipeline are:

 AT&T Point-to-Point

e AT&T Custom Multipoint (sometimes called AT&T Custom or AT&T
Multipoint)

e National ISDN-1 (commonly called NI-1, which runs on either the AT&T or
DMS-100 switch)

e DMS-100 Custom.

The phone company will tell you which type of service you have.

Directory numbers and SPIDs

Every service from the phone company comes with a number. In the case of
ISDN, there are a lot of numbers:
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* Two directory phone numbers, one for each B channel, in standard phone
number format, with an area code, prefix, and local number.

» Two service profile identifiers, called SPIDs, that come in a variety of
formats. The important thing to remember about SPIDs is that every digit is
important—don’t think of them in terms of area codes or prefixes. Think of
them as an ID that just looks like a phone number.

The Pipeline comes with an AutoSPID utility that tries to guess the SPID, basing
its guess on the switch type and the directory number. But because SPID formats
are not 100% standard, you should know the SPIDs associated with your ISDN
service. The directory numbers and SPIDs are needed during set up. (They enable
your Pipeline to connect to the switch at the central office.)

There is one exception: AT&T Point-to-Point comes with only one directory
number and no SPIDs. It only has one B channel.

Security and Transport protocols

The Pipeline supports two types of logon security protocols:
» Password Authentication Protocol (PAP)

* Challenge Handshake Authentication Protocol (CHAP)
¢ Microsoft CHAP (MS-CHAP)

These are commonly used security programs. They reside in the Pipeline’s on-
board memory. They help you get connected to the remote computer without any
need for input on your part. They are automatically available when using MP or
MP+ (described below).

Depending on which method is used, the Pipeline negotiates with the other end to
exchange your name, password, and other necessary information.

Once you get connected, both ends need to agree on how to transport the data.
Both the dialing end and the answering end of the link must support which ever
protocol is decided on. The Pipeline supports the following transport protocols:

2Point-to-Point Protocol (PPP) is the industry-standard for encapsulating data
packets (imagine small chunks of data being put into electronic envelopes) to
send over a single-channel connection. PPP is the most common protocol used
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when dialing from a personal computer to a corporate LAN or Internet Service
Provider.

Now what?

Multilink Point-to-Point Protocol (MP) is a method of combining

individually dialed channels into a single, higher-speed data stream. So if

you have one B channel connected, and you use MP, a second B channel can
be linked to the same connection.

Ascend’s Multilink PPP (MP+) lets a Pipeline add or remove channels from
a connection as bandwidth needs change, without disconnecting the link.
This is called Dynamic Bandwidth Allocation and is not available with MP
(above).

Bandwidth Allocation Control Protocol (BACP) is the industry standard for
bundling two B channels together, evaluating the traffic demands, and
adding or dropping the second B channel as needed.

V.120 (pronounced V dot one twenty) converts data from a PC’'s COM port
into ISDN data format. PCs send data in asynchronous mode, that is, they
use start and stop bits to mark the ends of a byte of data, and sometimes they
add a parity bit for error checking. ISDN sends data in synchronous mode,
that is, in long streams, with much less overhead.

After you configure your Pipeline to connect to your corporate office or to the
Internet, what software can you actually use to make things happen? The Pipeline
Companion CD comes with MAXLink Pro, a library of software packages and
documentation, including telnet, ping, finger, gopher, ftp, email, and more, to
help you reach other computers and transfer data. Plus, the CD-ROM includes
software to browse the web so you can do all the things you bought your Pipeline
to do.
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Configuration

The Pipeline 15 Setup Wizard requires that the Pipeline 15 be connected to a PC
running Windows 3.1, 95, or NT 3.51 or 4.0. TCP/IP must be installed on your
computer to connect to the Internet or a TCP/IP network. For Windows NT, also
install Remote Access software. Dial-Up Networking is supported on Windows
95 and NT.

Configuring your Pipeline consists of the following general steps, each of which
is described in greater detail in the next section:

* Run the setup wizard to identify the switch, directory phone numbers, and
SPIDs associated with your ISDN service. You can also use the setup wizard
to register your Pipeline and download a new version of the Pipeline 15
unit's on-board software.

* Next, define the Pipeline 15 as a modem on your computer. You define a
modem for each type of transfer protocol, that is, one for PPP, one for V.120,
and so forth.

* For Windows 95 and NT, create Dial-Up Networking shortcuts to automate
calling. For Windows 3.1, create connection settings in your
communications software, and add the required initialization strings used by
the Pipeline 15.

« Customize the Pipeline connection settings. Use HyperTerminal (which
ships with Windows 95 and NT), the Windows 3.1 Terminal accessory, or
any communication software that supports VT100 emulation. Use AT
commands to create a custom connection environment and save the
connection information as a numbered profile. The Pipeline stores profiles in
non-volatile RAM (NVRAM), which retains the data even if the power to the
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Using Pipeline 15 Setup Wizard

Pipeline is turned off. The AT Commands section describes how to
customize the Pipeline.

Using Pipeline 15 Setup Wizard

The Pipeline 15 Setup Wizard opens a communication channel and attempts to
make a direct connection to the Pipeline. The Pipeline is found if it is powered on
and the serial cable is securely fastened at both ends to an enabled port on your
computer.

£ Pipeline 16 Setup Wizerd
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llﬂE"' ¢ Smarchng fmrFipeies 1§
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When the wizard finds the Pipeline, it reads any settings currently stored on the
Pipeline and attempts to detect an ISDN signal. If the service is not installed, you
can manually configure your Pipeline, but you won't be able to test it.
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Using Pipeline 15 Setup Wizard

Troubleshooting tips

If the wizard cannot find the Pipeline, it lists available ports and waits for you to
specify the port of the Pipeline. If the port of the Pipeline is not on the list, the
port is occupied by another device or process. In this case, double check your
port settings.

Be sure there is no activity on the Pipeline’s port. For example, if a
communications program is connected to the Pipeline, the wizard sees the port as
busy, so won'’t detect the Pipeline. If this is the case, quit the communications
program and restart the wizard.

A port can be enabled or disabled on the basis of a system setting. Check the
control panel settings for the available ports to be sure you are using one that is
enabled.

If the ISDN signal cannot be detected, make sure the cable is securely attached at
both ends, and that it is plugged into the ISDN port on the back of the Pipeline. If
you think there a problem with the line, call the telephone company and have it
tested. Keep your Pipeline powered on in case the test needs to reach it.

Finally, power off the Pipeline and power it back on. Wait until the lights on the
front of the Pipeline indicate carrier detected (third light on), the Pipeline is clear
to send (5th light on), and the ISDN status is on or blinking (6th light). Try the
wizard again.
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Using Pipeline 15 Setup Wizard

"'-r Pipeling 15 Felup YWicesd

Plusin solocl one o B lallisisg opian

o i e caky Confgune the Fipabne 15
Sefact Big opios m slow the Fpaine 1o siomahcslb deed e
Iuimphces compan: pwilch ke I acdibon s opton wil

;‘ g rveslivally deaing Mo necdE sy BP0 Aunbsis
 Wbarasiky Cormligare e Pipeiee 19
IIEE"I Sedmct Bis opion by maneaky s leck e elkep bons company wwich
Fypia and he 4 SFD rumi Thes opfeon shaskd be used

Wil Cmain IS0V sswichers st cnnot ba comligere d sutoem sicaly.

£ i Bia Pipahisa 15 Casliguralos

Selad B cplios o owey all of e Pesbes 15 cenfizuesien
pamraiers Cnly pEesmnrs o by this prograe sl e deplsyed

 Arrais he Pipading 15 Tooli Mesi

Sl et Bis ol 1o diapley e Pipeling 15 ieoli mesu Fromhis
e w0k Wl e ebi o e e ESDR o spsgpshed saur Fipaebne 15
cipenizad new rmsssns, ancl peos snd e pions the cument

coll guraiiog.

1F"rhtl.r||| T | Exit

Select Automatically Configure the Pipeline. Make a different selection at
anytime by returning to this screen. Simply click the Previous button as many
times as needed.

Other options let you:

* Manually configure the Pipeline to change one or all settings.

* View the configuration to see what is currently saved.

* Make another test call.

* Register the Pipeline.

* Update the unit’s on-board software with new software obtained from
ftp.ascend.com.

* Save a configuration stored on the Pipeline to a file on your computer.
» Load a configuration file from disk to the Pipeline.
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Using Pipeline 15 Setup Wizard

Enter the phone numbers and enable the line(s) you want the Pipeline to use for
data calls. You can make and receive voice calls even if a data call is in progress,
S0 you can enable both lines for data and still use all the voice features of the
Pipeline. See the section on Voice calls to see how the Pipeline handles voice
calls.
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The wizard contacts the switch and determines its type, then it guesses the
SPIDs. Double check the numbers very carefully. Most ISDN setup problems are
due to incorrectly entered SPIDs. If the SPIDs offered by the wizard are different
from the SPIDs the telephone company gave you, carefully enter the numbers
from the phone company. (But if your test call fails, have the wizard guess the
SPIDs again, accept them, and make another test call.)

Pipeline 15 User’s Guide



Using the Pipeline 15 Setup Wizard
Using Pipeline 15 Setup Wizard

.].:. Pipeling 15 Felup YWicesd

il
.‘ ~ Paimi To Point (+129)
ASCEND Salectthiz 0pbon 10 provide ConECiMly Debeessn your Gompuier ond
———

ﬁ Salectthis opban o preade mesamum headwicth accees o he ismst

Sl Dpurnling ko

& ﬁlﬁl.ﬁiiﬁ
S bt thi oo n o provide dasdad basdwidth aecsdi 1o Ba lsemel va
i Iripmiet 5 ereicn Prosad e (155

iRl Aot (WP

i B | e e Saraca Prossdar (P

i mel Arcees [WPs|

Smlact this opbon o predde tynemic basdwitkh proess o fBe insmet v
an Inkemet S eracs Prsadies [I5F)

i Friraadui | | Flacd 3 I Cangal

If you are going to be connecting to the Internet or a TCP/IP network

Choose PPP to use a single B channel (this is your only option if you enabled
only one phone number).

Choose MP to use two B channels. If the far end cannot accept a two-
channel call, the protocol automatically switches to PPP.

Choose MP+ to use Dynamic Bandwidth Allocation, which uses one or two
B channels as needed. If the far end cannot negotiate an MP+ connection, the
protocol automatically switches to MP.

If you are going to be dialing another personal computer with an ISDN line,
choose V.120.
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The sample number was set up expressly for testing your Pipeline, and you can
use it. You can also make a test call to the number you plan to use to make ISDN
calls.
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When you click Make Call, depending the on the calling mode, one or two of the
B-channel lights on the front of the Pipeline go on. Then the transmit data (tx)
light goes on momentarily. The test can take up to 90 seconds. A dialog will tell
you if the test was successful or not.

If the test failed, do the following:

» Try another number. Go back to the previous screen, enter another number,
click Next and Make Call.

» Click Cancel to go back to the screen where you can View the Pipeline 15
Configuration. If any item is incorrect, correct it by selecting Manually
Configure the Pipeline 15, then make another test call.
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This completes the Pipeline configuration.

Next you'll add the Pipeline as a modem to your computer.
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Adding the Pipeline as a modem

To add a modem to Windows 95 or NT 4.0, start by opening the Control Panel,
and double clicking the Modem icon. From the Modem Properties dialog, select
Add.
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Click “Don’t detect my modem; | will select it from a list.”
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On the next panel, click Have Disk.
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Specify the location of the Pipeline 15 modem information file (named
MdAscend.inf) in the Install from Disk dialog box.
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Create a Pipeline modem for each type of transport protocol you plan to use. For

Internet and remote ISDN access, create Pipeline modems which use PPP, MP, or
MP+. For connecting to another PC, create a modem that uses V.120.
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Identify the COM port of the Pipeline. Be sure it's the same one you used in the
setup wizard. All modems for the Pipeline use the same COM port.
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Since the Pipeline can be customized to use a number of options, you might want
to set up multiple versions of each modem, with special AT commands associated
with each one. To do so, open the properties window for a modem. (From the

Control Panel, double click the Modems icon, select a Pipeline modem, and click
Properties.)
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Click the Connection tab, and then click Advanced.
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Here you can enter the unique AT commands for this Pipeline modem. (See the
AT Commands section for information about selecting AT commands for specific
results.)
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With these Pipeline modems, you can set up Dial-up Networking shortcuts to
initiate calls automatically.

Windows NT and Remote Access Service

Adding a modem in Windows NT 4.0 and Windows 95 is the same, except that in
NT only one modem can be defined per COM port. Additionally, when modem
information changes, NT needs to reboot and Dial-up Networking needs to be
reconfigured. Follow the on-screen prompts to remove, then add, and reconfigure
Dial-up Networking to swap modems.

To minimize rebooting, define an MP+ modem for Internet and TCP/IP
connections, and a V.120 modem for PC-to-PC connections. When necessary,
MP+ automatically drops down to MP, which in turn automatically drops down to
PPP as needed. This gives you the fastest possible connection on every call, and
all the swapping takes place in the Pipeline.
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Adding the Pipeline as a modem

After using the Pipeline 15 Setup Wizard to configure the settings on the
Pipeline, you need to add the Pipeline as a modem. This section describes how to
use the Remote Access Service (RAS) to add a modem.

You need to append the Pipeline modem information file to the RAS modem
information file in order to define the Pipeline as a modem. To accomplish this,
perform the following steps:

1 From the Windows desktop, open Notepad. If the program is not on the
desktop, select Run from the File menu, type Notepad, and press Enter.

2 From Notepad’s File menu, open the Pipeline modem information file. The
name of the file is MdAscend.inf and is located in the directory where you
installed the setup wizard. If you did not install the wizard, but ran it from
the CD, search for the file, using File Manager, on the CD.

3 Select the entire contents of the MdAscend.inf file and copy it to the
clipboard. (The menu commands to do this are, Edit > Select All, Edit >
Copy.) Close the file.

4  Open the RAS modem information file called modem.inf. Go to
CAWINNT35\SYSTEM32\RAS (where C:\WINNT35 is the location of
your Windows NT operating system).

5 At the end of the file, paste the contents of the Pipeline modem file by
selecting Edit > Paste. Close the file and save it.

Now the Pipeline will be listed from the modem selection dialog, whenever you
add a new modem in RAS.
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Defining the Pipeline as a modem

From the Control Panel, select Network settings. Select Remote Access Service
and click Configure.
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In the Remote Access Setup dialog, if a modem was previously defined on the
port the Pipeline is now attached to, remove it. Click Add to define the Pipeline.
Select the port to which the Pipeline is attached.

Next, choose cancel from the information dialog suggesting that Remote Access
search for the new modem.
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In the Configure Port dialog, select the type of Pipeline modem you want to
define.
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In the Remote Access Setup dialog, the type of Pipeline you selected will be
listed. Click Continue.
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Whenever a new modem is added, Windows NT needs to reboot.

Set up a connection and dial

In the Remote Access Service program group, select Remote Access to use the
Pipeline to dial a call.
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Each connection you make is an entry in the Remote Access Phone Book.
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Supply an Entry name, phone number, and description. If you click “Authenticate
using current user name and password,” the uses your Windows NT sign-on user
name and password. Be sure the COM port setting is correct.

Click on the Network icon to access the Network Protocol settings.

5-4
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Be sure to find out from the administrator of the remote system how you should
configure your PPP TCP/IP settings. The settings for IP address and Server
assignments will be given to you by the administrator of the remote system.

You can now use the Pipeline to make calls.
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6

Adding the Pipeline as a modem
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After using the Pipeline 15 Setup Wizard to configure the settings on the
Pipeline, you need to add the Pipeline as a modem. This section describes how to
configure a TCP/IP interface (which in this context, is a Pipeline modem), and
use it to make dial-up connections.

First install TCP/IP from MAXLink Pro, which is included on the Pipeline

Companion CD. Next, customize TCP/IP, by clicking on the Custom/Configure
icon. From the Inteface menu, select add.
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Create a new Serial interface. Use the drop-down arrow at the end of the Type
field to select PPP as the type of interface. You can start with this selection for
each modem you create, regardless of the type of protocol the modem will

actually use. For example, if you are adding a modem to make V.120, PPP, MP, or
MP+ calls, use these settings to start.
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T

Click OK to add the interface. Double click on the new interface to begin
configuring it. This brings up a tabbed dialog that is filled in as described next.

In the IP Configuration tab, if the administrator of the remote system gives you a
specific IP address, enter it in the Internet Address box. Otherwise, in the
Dynamic Configuration box, specify how your IP address is assigned. Find out
from the remote administrator which method the server uses. Leaving all settings
blank (as shown here) lets the server choose the method.
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The administrator of the remote system must supply Name Resolution
information. The Name Resolution tab assigns the IP address of a Domain Name
Server. This information may not be required if you obtain your IP address
automatically. If you sign up for an ISDN account with an Internet Service
Provider, ask your account administrator for this information (or if it is needed).
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If you are using your ISDN line to connect to a corporate LAN, your system
administrator will supply you with this information. For information on what a
Domain Name Server is, refer to the Networking Glossary on the Pipeline
Companion CD-ROM.
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The administrator of the remote system must supply Gateway information. The
Gateway tab lets you define the IP address of the system you will call into. It may
not be required if you obtain your IP address automatically. If you sign up for an
ISDN account with an Internet Service Provider, ask your account administrator
for this information (or if it is needed). If you are using your ISDN line to
connect to a corporate LAN, your system administrator will supply you with this
information. For information on what a Gateway is, refer to the Networking
Glossary on the Pipeline Companion CD-ROM.
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In the Port tab, specify the COM port to which the Pipeline is attached. Note that
on some systems, you need to select a baud rate no greater than 57600 so that
your computer can detect the COM port. Reducing the rate here does not affect
the transfer rate of connections made with the Pipeline.
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Use the Dial tab to set up the number you are going to call. (Alternatively, add the
number to dial in an address book entry of the Dialer program.)
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In the Modem t

ab, for the model, select the 9600 baud Hayes-compatible

modem. For the settings, enter the AT commands used by the Pipeline, as
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described in the following table. (Note that not all the settings show in the
Modem Init field in the illustration. Be sure to use the settings from the table

below.)
When used: AT command settings:
V.120 AM~AT EO V1 W1 &C1 &D2 &K1 &S0 S0=0 S71=2 S73=0 S95=47"M
PPP ISDN AM~AT EO V1 W1 &C1 &D2 &K1 &S0 S0=0 S71=1 S73=0 S95=47"M
MP ISDN AM~AT EO V1 W1 &C1 &D2 &K1 &S0 S0=0 S71=3 S73=0 S95=47"M
MP+ ISDN AM~AT EO V1 W1 &C1 &D2 &K1 &S0 S0=0 S71=4 S73=0 S95=47"M
Dial Prefix ATD
Dial Suffix M
Answer Setup | "M~ATS0=1"M
Hangup ~~~+++~~~ATH

In the Login tab, optionally enter your user name and password. You can be
prompted for a user name and password as you indicate for each address book
entry in the Dialer.
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You must enter the two characters -i (minus lowercase i) in the Script field, as
shown. Then click Done.
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When all the tabs are filled in as needed, click OK. If you entered a number to
dial, to make a test call, from the Custom dialog, select the new interface (click
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once on the line item) and click Connect from the title bar. If you selected “Open
log when connecting’
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In this illustration, two interfaces have been set up.

From the Custom/Configure program group, select the Dialer. You can set up
custom connections to various remote sites, using the Pipeline modems defined
here as interfaces. The configure button will give you a number of options to
customize each connection. Refer to the on-line documentation for the Dialer for

more details.
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This completes the Pipeline configuration for Windows 3.1 and Windows for

Workgroups.

6-14 Preliminary October 3, 1997

Pipeline Reference Guide



Macintosh Modem Setup 7

Adding the Pipeline as a modem

To use the MacTCP/IP software from Apple, you need System 6.0.5 or later.
Open Transport is the TCP/IP stack shipped with System 7.5.2 and later. These
instructions are based on System 7.5.2 and the Zterm communications package
(available on the Ascend ftp site).

To define the Pipeline as a modem, access TCP/IP from the Apple Menu >
Control Panel > Open Transport. A single dialog is displayed.

Connect via MacPPP. From the File menu, select Configurations and make a new
connection for the Pipeline, which is the equivalent of a modem that you can use
when dialing from your communications package.

The administrator of the remote system will give you all the information you
need to specify which protocol to use to obtain your IP address.

Next, in your communications package, create a new connection. For example, in
Zterm, select Dial > Manual, and fill in the number to dial and other options.

The settings for the modem should be as follows:
o Datarate 57600

» Data bits 8
e Stop bits 1
o Parity none

Flow control is not required.
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Selecting a data rate of 57600 enables the communications software to find the
modem port. It does not control the transfer rate used by the Pipeline.

You can now use the Pipeline to make calls over your ISDN line in the same way
you would make calls with a modem.
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Analog services

An ISDN telephone line can carry data or voice or both at once. You can use the
Phone 1 and Phone 2 jacks on the Pipeline to connect standard telephones, fax
machines, or other analog telephone equipment to the same ISDN line you use

for data.

How the Pipeline handles outgoing voice calls

ISDN service can be provisioned so that each B channel can carry either voice or
data. When used for voice, a B channel can carry a single voice call.

The voice-handling features of the Pipeline make it easy to make outgoing voice
calls. If either of the B channels is currently not in use, you can dial a voice call
from a telephone connected to either phone port. If you pick up the receiver of the
phone connected to the channel that is in use, the Pipeline uses the other one.
There are only two exceptions:

» Ifthe type of ISDN service is AT&T Custom Point-to-Point, there can be
only one voice call at a time. Because AT&T Custom Point-to-Point service
includes only one telephone number, all outgoing voice calls use that
number.

« If the switch is a Northern Telecom DMS-100, and Phone Number Binding
is enabled (by setting S55 to 1), you cannot make the call if the currently
used B channel and the analog port to which the phone is connected both use
the same telephone.

But in the latter case, pick up the receiver of the phone connected to the other
channel.
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You can place a voice call if both B channels are in use for a data call to the same
location. Pick up the receiver of a telephone connected to either analog port. The
Pipeline automatically borrows one of the B channels for the voice call. This
feature works for outgoing calls on all types of ISDN service and all switches.

You cannot place a voice call if both B channels are engaged in voice calls, one
voice call and one data call, or two data calls to different locations.

How the Pipeline handles incoming voice calls

The voice-handling features of the Pipeline make it easy to receive incoming
voice calls. In the most common configuration, where each analog port is
assigned to a different telephone number, the Pipeline handles incoming voice
calls as follows (except with AT&T Custom Point-to-Point service, discussed
below):

» If neither B channel is currently in use, you can receive a voice call on either
telephone number.

« Ifasingle B channel is currently in use for a data call, you can receive a
voice call on either telephone number. The unused B channel carries the
voice call, but the Pipeline routes the call to the analog port that is assigned
to the telephone number dialed by the caller.

» Ifasingle B channel is currently in use for a voice call, you can receive a
voice call for the telephone number not used by the current voice call.

» Ifasingle B channel is currently in use for a voice call, and there is an
incoming call to the same telephone number as the current call, the caller
receives a busy signal.

» If both B channels are in use for a data call to the same location, you can
receive a voice call to either telephone number. The Pipeline automatically
borrows one B channel for the voice call, and routes the call to the analog
port assigned to the telephone number.

» If both B channels are used for any other combination of calls—for two
voice calls, for one voice call and one data call, or for two data calls to
different locations—the Pipeline cannot handle another voice call, and
callers to either telephone number receive a busy signal.

8-2
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Incoming voice calls are handled differently with AT&T Custom Point-to-Point
service. Because this service includes only one telephone number, it can
accommodate only one voice call at a time. Therefore:

« Ifasingle B channel is currently in use for a data call, you can receive a
voice call. The call is routed to the Phone 1 port.

» Ifa B channelis currently in use for a voice call, a caller to the telephone
number receives a busy signal.

« If both B channels are in use, a caller to the telephone number receives a
busy signal.

Note: If you have enabled Data Over Voice (by setting S register 61 tol), the
Pipeline receives an incoming voice call as a data call, not as a voice call.

Using Call Waiting

The Pipeline supports Call Waiting, a feature that generates a distinctive tone
when you are using a telephone number for a voice call and another voice call is
made to the same telephone number. The Call Waiting tone, which is generated
by the Pipeline, is either an approximation of the Call Waiting tone provided by
most telephone companies or, on a Pipeline with a U interface, a brief “burr”
tone.

To use Call Waiting:

1 When you hear the call waiting tone, decide whether you want to answer the
new call.

2 If you do want to answer the new call, put the current call on hold by quickly
pressing and releasing your telephone’s switchhook (the button that is
depressed when you hang up the telephone).

3 Toreturn to the first call, quickly press and release your telephone’s
switchhook again. This puts the second call on hold.

Using Call Hold

The Pipeline lets you put the current call on hold, using the following steps:

1 Quickly press and release your telephone’s switchhook (the button that is
depressed when you hang up the telephone). You can now make another call.
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2 To return to the call you put on hold, quickly press and release your
telephone’s switchhook again. If you have a second call, this puts the second
call on hold while you take the first call.

Call conferencing

If your ISDN service includes the Call Conferencing feature, you can use the
Pipeline to establish conference calls. Conference calls allow more than two
callers to converse at the same time. If the Call Conferencing feature is available
from your telephone company, it allows either three-way conference calls (which
include you and up to two other callers) or six-way conference calls (which
include you and up to five other callers).

To establish a conference call, follow these steps:

1 Call aperson to include in the conference, or have that person call you.

2 Put the call on hold by quickly pressing and releasing your telephone’s
switchhook (the button that is depressed when you hang up the telephone).

3 Call another person to include in the conference, or have that person call
you.

4  Add anyone on hold to the call by quickly pressing and releasing your
telephone’s switchhook twice.

5 To add more callers to the conference call, repeat steps 2-4.

A caller normally leaves a conference call by hanging up. You can also drop the
most recently added caller to a conference call by following this step:

Quickly press and release your telephone’s switchhook twice.

Caller ID supported

The number of the calling party is included in the ISDN BRI data stream. You
can capture the number, unless the caller has blocked it, by attaching a CallerID
device to the POTS ports on the unit.
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The Pipeline 15 provides an extended AT command set. AT commands are
standard software commands used to control modems (AT stands for ATtention).
You enter the commands in a terminal emulation window (available in
HyperTerminal, which ships with Windows 95 and NT, Terminal, which ships

with Windows 3.1, or Zterm for the Mac). You can use the special AT commands
developed for the Pipeline 15 to configure phone connections and ISDN
connections. Enter the commands directly when setting up a call, or include them
in your modem settings to set up custom configurations for each connection. (See
“Using AT commands,” at the end of this section for examples.)

Command Description

A Answers offered call.

Ds Dials a string of numbers.

Ds; Returns to command mode after dialing.
DS Dials stored number.

DL Redials last number.

EO Disable echo.

El Enable echo (default).

F255 Clears non-volatile RAM (nvram).

H Switch hook control—disconnects an active data call.
In Return information about the unit as follows:
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ISDN

10 Returns product code.
11 Returns ROM CRC. (Always returns zero.)
12 Test ROM CRC. (Always returns OK.)
13 Returns firmware revision.
14 Returns feature ability bitmap. (Always returns zero.)
16 Returns a page of statistics on connection status.
17 Returns the unit’'s serial number.
0] Returns to online mode from data mode
Qn Enable/disable result codes. Used to configure the S-registers as follows:
Qo0 Result codes enabled (default).
Q1 Result codes disabled.
Q2 Result codes enabled when in originate mode.
Sr=n Sets S-register number.
Sr? Reads the S-register number’s configuration.
VO Result code format: number code.
V1 Result code format: long form (default—see table below).
Wn Negotiation progress code format.
Result code formats may be selected using S95 (see below).
Note: Short form result codes are defined by the AT modem standard.
short form codes must be selected.
WO Negotiation progress messages disabled (default).
w1 Negotiation progress messages enabled.
CONNECT messages show DTE speed.
w2 Do not return negotiation progress messages.
CONNECT messages show DCE speed.
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X0 Enable Result Number Codes O - 4.

X1 Enable All Result Number Codes except Busy (7).

X2 Enable All Result Number Codes.

YO Long space disconnect function disabled (default).

Y1 Disconnect on BREAK received from remote. Duration 1.6 sec. Send BREAK
on disconnect. Duration 4 sec.

Zn Resets the Pipeline and restores the nth profile. The n parameter selects a stored
profile. (See S Registers for information about stored profiles.)

&Cn Reports the state of Receive Line Signal Detect (Risgghal V.24, pin 8).

&CO0 Force RLSD ON (default).

&C1 Follow remote RLSD.

&C2 RLSD always on, until DISConnect received (ISDN option), until remote
RLSD absent.

&Dn Selects Data Terminal Ready (DTR) option (signal V.24, pin 20).

&DO0 Ignore DTR. (default)

&D1 Monitor DTR, DTR ON to OFF transition: enter command mode.

&D2 Monitor DTR, DTR ON to OFF transition: disconnect, and enter command
mode.

&D3 Monitor DTR, DTR ON to OFF transition: disconnect.

&Fn Loads one of six factory profile settings into the active profile.

&FO0 Hayes-compatible profile.

&F1 IBM PC compatible profile.

&F2 Macintosh software handshake compatible profile.

&F3 Macintosh hardware handshake compatible profile.

&F4 Motorola Bit Surfer compatible profile.
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&F5 3-com Impact compatible profile.

&F6 Adtran Express compatible profile.

&Kn Local and end-to-end flow control options. (Also see \Qn commands)

&KO0 Disable local flow control.

&K1 Enable RTS/CTS flow control (default).

&K2 Enable XON/XOFF flow control.

&K3 Enable RTS/CTS flow control.

&Sn Data Set Ready (DSRignal V.24, pin 6) options.

&S0 DSR always ON (default).

&S1 DSR on after Data Mode.

&S2 DSR on after protocol successfully established.

&Vn Views the nth stored profile.

&W Writes a subset of the parameters from the active configuration profile into
nonvolatile RAM (NVRAM). The information in NVRAM is retained (even
when you turn off the Pipeline) and can be recalled later using the Z command.
The n parameter lets you save configurations. If you don't specify a value for
n, the configuration is saved as 0.

The &W command saves S registers S0, S7, S18, and S25 and saves the set-
tings for commands E, Q, V, Y, &C, &D, &G, &S, %A, and %E.

&Yn Selects a stored profile on power up.

&Y Same as &YO0.

&Y0 Selects profile O (previously saved using &WO0) at power on (default).

&Y1 Selects profile 1 (previously saved using &W1) at power on.

&Zi=n Stores a phone number and its dial modifiers in nonvolatile RAM (NVRAM).
NVRAM retains the stored number even when the Pipeline is turned off.

To dial a number stored in NVRAM with the &Z command, use the DS gom-
mand.
9-4 Pipeline 15 User’s Guide



AT Commands

S Registers

&Z0= A valid phone number and modifiers < 20 alphanumeric characters
&Z1= A valid phone number and modifiers < 20 alphanumeric characters
&Z2= A valid phone number and modifiers < 20 alphanumeric characters
&Z3= A valid phone number and modifiers < 20 alphanumeric characters
\Qn Local and end-to-end flow control options. (Also see AT&Kn.)

\QO Disable local flow control.

\Q1 Enable XON/XOFF flow control.

\Q3 Enable RTS/CTS flow control (default).

$H Displays help information.

S Registers

These S register commands are a subset of the AT commands created for
line. They are separated from the main set of AT commands for easy refe

the Pipe-
rence.

Command Description

SO=n Controls auto answer and rings to answer.

S0=0 Disable auto answer

S0=1 Enable auto answer

S2 Controls escape characters recognized.

S3 Controls command termination character recognized.

S4 Controls line feed character recognized.

S5 Controls back space character recognized.

S7 Controls the amount of time the originating ISDN modem will wait for RUSD

from the answering ISDN modem. The default is 50 seconds, configure
second intervals from 1 to 255.
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Hayes

valid
rom O

S Registers

S12 Controls the inter-character escape sequence timing. The default is 50
Units (HayU’s) configured from 0 to 255. 255 HayU’s equal 5.1 seconds

S25 Controls the DTR guard time. The amount of time DTR must be low for a
OFF. The default is .05 seconds, configurable in .01-second increments
to 255.

S30 Controls the inactivity time before disconnect. The default is O (never discon-
nect). Configured from 0 to 255 in 10-second increments.

S42=n Holds the current line status of the ISDN line, as follows:

S42=0 No Physical connection detected.

S42=1 Physical connection detected.

S42=2 ISDN Layer 2 active (meaning that the telco switch can be found).

S42=3 Multi Link established.

S42=4 End point initialization completed with telephone switch.

S43 Holds the speed at which the ISDN modem made its most recent connegtion.

S46= Controls data compression ON/OFF.

S46=0 No compression.

S46=2 Attempt compression. (default)

S50=n Controls the switch type the Pipeline attempts to use to establish a connection.

S50=0 ATT Point-To-Point.

S50=1 ATT 5ESS Custom.

S50=2 NI-1.

S50=3 DMS-100 Custom.

S50=4 Auto-SPID (default).

S51= Configures the first ISDN phone number (up to 20 characters).

S52= Configures the ISDN SPID associated with the first ISDN phone numbef.
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S53= Configures the second ISDN phone number (up to 20 characters).

S54= Configures the ISDN SPID associated with the second ISDN phone number.

S55= ISDN analog port phone number binding. This register selects between stati-
cally bound phone number binding and dynamic phone number binding on
DMS-100 and NI-1 ISDN switches as follows:

S55=0 Dynamic phone number binding (default).

S55=1 Static phone number binding.

S56=n Phone port 1 configuration:

S56=1 Associate ISDN phone number A with port 1.

S56=2 Associate ISDN phone number B with port 1.

S56=0 Disable phone port 1.

S57= Phone port 2 configuration:

S57=1 Associate ISDN phone number A with port 2.

S57=2 Associate ISDN phone number B with port 2.

S57=0 Disable phone port 2.

S58=n Phone number usage.

S58=1 Use ISDN phone number A for data connections.

S58=2 Use ISDN phone number B for data connections.

S58=3 Use ISDN phone number A + B for data connections.

S59= Phone port 1 call type configuration:

S59=0 Speech

S59=1 Audio

S60=n Phone port 2 call type configuration:

S60=0 Speech
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hed
is set-

ity.

S Registers

S60=1 Audio

S61=n Configures the Pipeline to allow Data Over Voice (DOV). If you provisio

one B channel for voice (which might be less expensive) you can use th
ting to enable data calls over a voice line.

S61=0 Disable

S61=1 Enable

S62 Supplementary service conference ID (0 to 255). The default is 6.

S64 Supplementary service transfer ID (0 to 255). The default is 7.

S65 Supplementary service drop ID (0 to 255). The default is 8.

S66 Supplementary service hold ID (0 to 255).

S68= Sets the B channel rate as follows:

S68=56 Sets transmission to 56Kk.

S68=64 Sets transmission to 64k.

S71=n ISDN B-channel rate adaption protocol:

S71=0 AutoSelect (default).

S71=1 Async/Sync PPP conversion.

S71=2 V.120.

S71=4 Multilink PPP (MP).

S71=8 Multilink PPP Plus (MP+ or MPP).

S73= V.120 frame type configuration:

S73=0 Iframes.

S73=1 Ulframes (default).

S74= V.120 frame size from 240-256. The default is 256 for Adtran compatibi

S82= BREAK handling options (note that BREAK handling is protocol specific):
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Result codes

S82=3 BREAK is handled out of band, data integrity is ensured.
S82=7 Destructive timed BREAK.
S82=128 BREAK is handled in band, data integrity is ensured.
S86 Connection failure cause codes. See ISDN cause code table below.
S95=n Negotiation message-option detail reporting when in command mode:
S95=0 Extended messages disabled (default).
S95=1 Use DCE speed when reporting CONNECT messages.
S95=2 Append /ARQ to CONNECT when EC connection is made.
S95=4 Enable CARRIER messages (POTS only)
S95=8 Enable PROTOCOL messages.
S95=32 Enable COMPRESSION.
Result codes

Result codes are visible in a terminal emulation window. The result is for infor-
mation only. Result codes are not warning or error messages..

No. code Result code ISDN meaning
0 OK Command OK
1 CONNECT Connect with Far End
2 RING Incoming Data Call
3 NO CARRIER Call Not Completed
4 ERROR Error in Format
5 CONNECT 1200 Connect At 1200
6 NO DIALTONE Network Failure
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No. code Result code ISDN meaning

7 BUSY Far End Busy

8 NO ANSWER No Answer (@ only)

10 CONNECT 2400 Connect At 2400

11 CONNECT 4800 Connect At 4800

12 CONNECT 9600 Connect At 9600

13 CONNECT 14400 Connect At 14400

14 CONNECT 19200 Connect At 19200

17 CONNECT 56000 Connect At 56000

18 CONNECT 57600 Connect At 57600

19 CONNECT 115200 Connect At 115200

20 CONNECT 230000 Connect At 230000

25 CONNECT 12000 Connect At 12000

28 CONNECT 38400 Connect At 38400

32 CONNECT 48000 Connect At 48000

57 CARRIER 56000 ISDN Connection is 56Kbps

59 CARRIER 64000 ISDN Connection is 64Kbps
CARRIER 115000 ISDN Connection is 115Kbps
CARRIER 128000 ISDN Connection is 128Kbps
COMPRESSION:LZS | LZS Compression Enabled
COMPRESSION:PPP PPP Compression Enabled
COMPRES- Compression Disabled
SION:NONE

83 PROTOCOL:V.120 V.120 Rate Adaption
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No. code Result code ISDN meaning

PROTOCOL:PPP PPP Async To Sync Conversion Enabled

PROTOCOL:BOND- | Bonding Enabled (mode 1)
ING

ISDN Cause Codes

ISDN cause codes are visible when making calls in a terminal emulation window.
They enable you to diagnose your ISDN service and the status of an ISDN call.

Code Cause

Valid cause code not yet received

Unallocated (unassigned) number

No route to specified transit network (WAN)

No route to destination

Send special information tone

Misdialed trunk prefix

Channel unacceptable

Call awarded and being delivered in an established channel

Prefix 0 dialed but not allowed

Ol 0| N|]OO| O | Ml W[N] L[| O

Prefix 1 dialed but not allowed

[y
o

Prefix 1 dialed but not required

=
[N

More digits received than allowed, call is proceeding

[y
»

Normal clearing

=
~

User busy

=
oo

No user responding
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ISDN Cause Codes

19 No answer from user (user alerted)

21 Call rejected

22 Number changed

23 Reverse charging rejected

24 Call suspended

25 Call resumed

26 Non-selected user clearing

27 Destination out of order

28 Invalid number format (incomplete number)

29 Facility rejected.

30 Response to STATUS ENQUIRY

31 Normal, unspecified

33 Circuit out of order

34 No circuit/channel available

35 Destination unattainable

37 Degraded service

38 Network (WAN) out of order

39 Transit delay range cannot be achieved

40 Throughput range cannot be achieved

41 Temporary failure

42 Switching equipment congested

43 Access information discarded

44 Requested circuit channel not available
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45 Pre-emptied

46 Precedence call blocked

47 Resource unavailable, unspecified

49 Quality of service unavailable

50 Requested facility not subscribed

51 Reverse charging not allowed

52 Outgoing calls barred

53 Outgoing calls barred within CUG

54 Incoming calls barred

55 Incoming calls barred within CUG

56 Call waiting not subscribed

57 Bearer capability not authorized

58 Bearer capability not presently available
63 Service or option not available, unspecified
65 Bearer service not implemented

66 Channel type not implemented

67 Transit network selection not implemented
68 Message not implemented

69 Requested facility not implemented

70 Only restricted digital information bearer capability is available
79 Service or option not implemented, unspecified
81 Invalid call reference value

82 Identified channel does not exist
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83 A suspended call exists, but this call identity does not

84 Call identity in use

85 No call suspended

86 Call having the requested call identity has been cleared

87 Called user not member of CUG

88 Incompatible destination

89 Non-existent abbreviated address entry

90 Destination address missing, and direct call not subscribed

91 Invalid transit network selection (national use)

92 Invalid facility parameter

93 Mandatory information element is missing

95 Invalid message, unspecified

96 Mandatory information element is missing

97 Message type non-existent or not implemented

98 Message not compatible with call state or message type
non-existent or not implemented

99 information element nonexistent or not implemented

100 Invalid information element contents

101 Message not compatible with call state

102 Recovery on timer expired

103 Parameter non-existent or not implemented, passed on

111 Protocol error, unspecified

127 Internetworking, unspecified
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Using the custom AT commands 1 0

How to make a calling profile

To use AT commands in a terminal emulation window, open your
communications software and add a connection for the Pipeline. Specify that you
are directly connected to the COM port used by the Pipeline. If the software
offers a data rate, accet it. Otherwise, use 9600. Then set data bits to 8, parity
none, stop bits one, and flow control off (or none). Save the settings. In the
terminal window, type AT and press enter. When the Pipeline responds with OK,
you are ready to make or receive calls.

Answering an incoming call

To answer a call, open HyperTerminal (or your communication software). An
incoming call will appear as:

RING RING

To answer the call, enter the following AT command:
ATA

To hang up a call, enter:
ATH
Storing and dialing phone numbers

To store a phone number as phone number 1, enter the following AT command:
AT&Z1=18005551212
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How to make a calling profile

To recall the number and dial it, enter:
ATDS1

To dial a number not stored, enter:
ATD18005551212
Saving a group of AT commands
You can enter a group of AT commands to set up a call, save the commands as a

profile, and recall the profile with a single AT command. You can define u pto
four profiles using the &W comand, as shown in the following example.

Example profile

Below is an example of how to set up a a call, save the settings as a profile, and
reload th eprofile with a single AT command.

Function AT command
Set Idle Timer to 120 seconds. S30=120
Set the transmission rate of a data call to 64 Kbps. S68=64
Enable flow control. &K2

To set up the calling environemtn, start by entering AT, then type the command
for each function as shown below:

ATS30=120 S68=64 &K2"M

("M is a carriage return.) The Pipeline processes each command in the order
entered. You can add additional settings as needed.

To see the current settings, including most default settings (some are hidden),
enter:

AT&V
To write profile 1 with the above settings, enter:

AT&W1
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To load profile 1, enter
AT&Y1

You can add &Yn to a modem definition’s additional AT comands. Or use &Yn
in a session or connection defined in your communications software.

Loading a profile resets the Pipeline calling environment entirely (that is, you
cannot load more than one profile at a time, as each one overwrites the previous
one). If you entered a profile, and need to add additional commands, enter S
Register commands next, then other AT comands, and end with th enumber to
dial.
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Specifications A

Power requirements

\Voltage 90-130 VAC, 0.4A 47-63 Hz.
220-240 VAC, 0.2A 47-63 Hz.

Phase Single

Frequency 47-63 Hz

Power 11W (nominal) to 13.5W (maximum)

The Pipeline configuration profiles are stored in battery-protected memory.
When the Pipeline is turned off, the profiles are not lost. Be sure to use a

protected AC power source, or add surge protection between the power source
and the Pipeline.

Environmental requirements

For best results, the Pipeline should be installed in a room with constant
temperature and humidity. In general, cooler environments are better, and an
operating temperature of 32 to 104 Fahrenheit (O to 40 Celsius) is recommended.

Humidity should be high enough to prevent accumulation of static electricity, but
low enough to prevent condensation. An operating relative humidity of up to 90%
(non condensing) is acceptable. You can operate the Pipeline at altitudes of O to
14800 ft. (0-4500 m).
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Specifications

PC cable specifications

The RS-232 serial port uses a standard DB-25 female connector that conforms to

the EIA RS-232 standard for serial interfaces.

DB-9 pin Function Description DB-25 pin
1 DCD Data Carrier Detect 8
2 RD Serial Receive Data 3
3 SD Serial Transmit Data 2
4 DTR Data Terminal Ready 20
5 GND Signal Ground 7
6 DSR Data Set Ready 6
7 RTS Request to Send 4
8 CTS Clear to Send 5
9 RI Ring Indicator 22
- - Shield 1

A-2
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Specifications

Macintosh cable specifications

8-pin Mini DIN Function Description DB-25 pin
1 DTR Data Terminal Ready 20,4

2 CTS Clear to Send 5

3 SD Serial Transmit Data 2

4,8 GND Signal Ground 7

5 RD Receive Data 3

7 DCD Data Carrier Detect 8
Basic Rate interface

The Pipeline BRI interface is a Western Electric-type RJ-45 port. Connection be-
tween this port and the wide area network is via a non-integral, interconnecting
cable/connector set. U interface cables can be up to 18000 ft (5486m) in length.

U pinouts for BRI RJ-45 pin
transmit (output) + 3
transmit (output) - 6
transmit/receive (output) + 4
transmit/receive (output) - 5
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